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1. About this manual  
This manual is an extension to the AudioEditors_V6_UserManual, providing information to activate certain 
features that are described in the user manual. Features are explained that affect normal editor users only 
indirectly, such as save templates or sound card configuration. 

 Manual colors 

DAVID System manuals have different color codes according to the manual type: 

 

Admin Manual (blue): Admin manuals either describe DigaSystem 
modules with no significance for application users (such as DigAlign) 
or represent the configuration document to a user manual. This 
manual type is mainly relevant to system or DigaSystem 
administrators and assumes the reader to have full access to the 
DigaSystem administrating tools (mainly DigaSystem Administrator 
and/or DPE Admin). 

 

User Manual (red): User Manuals describe all functions of 
DigaSystem modules used for media production, such as DBM or the 
Audio Editors. It might however be necessary to consult a 
corresponding Admin manual to configure and/or activate some of 
the features.  

 

Technical Manual (green): Technical manuals provide technical 
details of DigaSystem products and interface information that can be 
used to develop own solutions for individual workflows. This manual 
type is usually only handed out under specific circumstances. 

 

 Manual icons 

There are some icons in this document to point out important information. 

 
License required Sections with this icon need a license to work.  

 New This icon appears in headlines and the content index. It marks new features or a 
changed behavior/workflow that has been recently implemented. 

 Admin info When this logo appears, then there is a chapter in the corresponding admin 
manual about this topic (the chapter or section usually has the same title in both 
manuals); e.g. how to activate a described feature. This also means the described 
function will not be available if not activated and configured. 

 
Hint This icon marks hints, tips and help. 
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 Parameter and subkey diction 

Subkeys A subkey is a folder in the parameter files’ tree structure as shown in the 
DigaSystem Administrator 

Parameter level Subkeys (sometimes also called folders) and parameters can be located in 
three different parameter files (levels): The Global Settings, the Local Settings 
and the User Settings. 

If the parameter level can be chosen at will, the parameter path is shown as 
e.g. …|Settings| (the three dots in the beginning) that indicate the Settings 
subkey of any parameter level. 

Vertical bar (|) and parameter 
syntax 

If the vertical bar (that separates the subkeys) appears at the end, then a 
subkey is meant, e.g. …|EasyTrack|Settings|Loudness| (the Loudness 
subkey in the Settings folder). Without the bar the manual refers to a 
parameter, e.g. (…|SingleTrack|Settings|TrackEdit). 

If a parameter value is pointed out or recommended it will be shown as 
Parameter=Value. As an example: UserNormalTracksizing=1 means, the 
parameter "UseNormalTrackSizing” is (or should be) set to 1. 

Variable <Editor name> The subkey variable <Editor name> or just <Editor> means the EasyTrack, 
MultiTrack or SingleTrack key, e.g. …|MultiTrack|Settings|. 

Default path in the manuals Parameters being listed without a reference path are always stored under 
…|<Editor name>|Settings|. 

 Abbreviations 

MTE MultiTrackEditor, delivered as the individual product MultiTrackV6.exe, which includes Reporter Box 
and Single Track components. 

MTS The MultiTrack screen of MTE. 

ETE EasyTrackEditor, delivered as the individual product EasyTrackV6.exe, which is a reduced version of 
MTE. 

ETS The EasyTrack screen of MTE. 

RMS The Record Mode screen of MTE. 

RBS The Reporter Box screen of MTE. 

STE SingleTrackEditor, delivered as the individual product SingleTrackV6.exe, which is a reduced version of 
MTE. 

STS The SingleTrack screen of MTE 

 



DAVID Systems Audio Editors-V6.5 – Admin Manual Page 7 of 39 

 

 

2. Track Recording and Routing 
The optional features Track Recording and Track Routing can be purchased from DAVID Systems. 

 Track Recording  

The Track Recording feature is only visible in MultiTrack Editor if the corresponding action right is enabled: 

In DigaSystem Administrator [User]|Rights|Actions|MTE_TrackRecording 

In DPEAdmin Users & Groups|[User]|Rights Matrix|MTE_TrackRecording 

 Track Routing  

Enables the routing of tracks to different audio channels of multichannel sound cards. This features affects all 
working screens of all Audio Editors. To make this feature available, the DigaSystem User needs the following 
right granted: 

In DigaSystem Administrator [User]|Rights|Actions|MTE_TrackRouting 

In DPEAdmin Users & Groups|[User]|Rights Matrix|MTE_TrackRouting 

Feature description: See the section Track Routing in the UserManual 

Sound card configuration: You can access the soundcard configuration via the menu Options -> Settings -> 
Audio Channels. See Tab Audio Channels in the UserManual 

Compatibility with older MTE versions: The track routing of an MTE session will be saved into the project. If 
such a project is loaded into an older MTE version (e.g. MTEv5), the channel routing will be routed the default 
way, e.g., the second track is routed to "Out 3+4”, the third to "Out 4+5” and so on. 
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3. Loudness  
There are several basic loudness features available in the Audio Editors: 

 Loudness Processing in the Clipboard 

 Loudness Meter (EBU-128) 

 Loudness Track 

 Loudness-Compliant Saving 

 Activate Loudness Features  

3.1.1. Requirements 

The editors need at least one configured LoudnessSet that defines whether audio material is loudness compliant 
or not. To set up such a LoudnessSet and loudness relevant configuration, please refer to the manual 
LoudnessInDigaSystem_AdminManual.  

The files LoudnessDLL.dll and LVC.ocx must exist in the editor directory for the loudness features to 
work. LVC.ocx has to be registered using regsvr32.exe. 

3.1.2. Global Loudness Sets 

A loudness set can be set as default settings for all Audio Editors. Based on this set, the editors will perform all 
loudness relevant calculations and metering. The key can be defined on GLOBAL, LOCAL and USER level in the 
|Common|Loudness| folder: 

  Key Description 
EditorLoudnessSet The entered value is the name of the loudness set (which is the folder name 

|Common|Loudness|<LoudnessSetName>|). This set is used by the Audio Editors 
as basis for any loudness calculation.  

Note for MTE: If this entry is missing all loudness features are disabled for the corresponding 
customer/computer/user. If the Loudness Set is invalid or incomplete, a message will be shown at editor startup 
indicating the source of the problem and that all loudness featured will be disabled. 

3.1.3. Loudness Normalization and Analysis in the Clipboard  

To activate these features, the Audio Editor user needs the new right MTE_LoudnessProcessing, which you can 
create under Objects|Actions by selecting New from the context menu in the Actions list and then typing the 
name of the right. The right is then selectable for all users under <User>|Rights|Actions|. 

Loudness normalization via the context menu of a clipboard element is available without any additional 
parameter. 

Automatic loudness analysis can be enabled by the parameter: 
 
…|…Track|Settings|Loudness|ClipboardAutoLoudnessAnalysis=1. 
 
When set to 0, the automatic loudness calculation is disabled, but still available via context menu. 
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3.1.4. Loudness Meter  

In the editor open the menu "View -> EBU-R128". The Loudness Meter can be embedded anywhere in the GUI 
or be displayed in a separate window.  

 
 
To activate the feature the Audio Editor user needs the right MTE_LoudnessMeter, which you can create under 
Objects|Actions by selecting New from the context menu in the Actions list and then typing the name of the 
right. The right is then selectable for all users under <User>|Rights|Actions|. 

The user right MTE_ChangeLoudnessDisplaySettings (under |User|<user>|Rights|Actions|) allows the MTE 
user to call the Loudness Meter settings via a right-click anywhere in the Loudness Meter pane.  

3.1.5. Loudness Track  

Displaying the loudness track requires the user action right MTE_LoudnessTrack, which you can create under 
Objects|Actions by selecting New from the context menu in the Actions list and then typing the name of the 
right. The right is then selectable for all users under <User>|Rights|Actions|. 

Loudness Track can be displayed through View > Loudness track menu item and toolbar button . 
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3.1.6. Loudness-Compliant Saving  

The activation of this feature requires a parameter under |Settings|Loudness|:  

Key Description 

CheckBox_SaveLoudnessCompliant 
 

Default=2. 

Show Loudness compliant checkbox in the 
audio save dialogs. The value 0 deactivates 
the check box feature, a value of 1 activates 
the check box and automatically selects it. 
With the value 2 the check box is available, 
but not checked. 3 means that the check box 
is selected and the user can not remove the 
check mark. 

  

 

  



DAVID Systems Audio Editors-V6.5 – Admin Manual Page 11 of 39 

 

 

 Loudness Visualization Controls Set  

Limits describing the maximum loudness compliance values are taken from a Loudness Set Core (as described in 
LoudnessInDigaSystem_AdminManual) and the name of the set to be used is 
defined by the parameter Common|Loudness|EditorLoudnessSet . An 
incomplete core set triggers a message when MTE starts and disables all 
loudness features:  
All other settings concerning the individual loudness controls (tolerances for 
visualization and their corresponding colors) are bundled in a Loudness 
Visualization Controls Set (LVC), which is an optional extension of a Loudness 
Set. 

Parameter Name Default Value Description 

LVC_Color_ILK_Above rgb(155, 155, 
155) 
(dark gray) 

ILK meter: Color above (Target Value + Tolerance). See 
IntegratedLoudnessTarget 
and ToleranceForIntegratedLoudness (both in Loudness 
Set Core). 

LVC_Color_ILK_Below rgb(215, 215, 
215)  
(light gray) 

ILK meter: Color below (Target Value - Tolerance) 

LVC_Color_ILK_Tolerance rgb(65, 176, 223)  
(petrol-blue) 

ILK meter: Color between (Target Value + Tolerance) and 
(Target Value - Tolerance) 

LVC_Color_LRA_Above rgb(243, 178, 0)  
(orange) 

SLK meter: Color above Maximum. See 
MaximumLoudnessRange in Loudness Set Core. 

LVC_Color_LRA_Below rgb(215, 215, 
215)  
(light gray) 

SLK meter: Color below Maximum 

LVC_Color_MLK_Above rgb(155, 155, 
155)  
(dark gray) 

MLK meter: Color above (Target Value + Tolerance). 
See MaximumMomentaryLoudnessLevel (Loudness Set 
Core) and LVC_MLK_Tolerance. 

LVC_Color_MLK_Below rgb(215, 215, 
215)  
(light gray) 

MLK meter: Color below (Target Value - Tolerance) 

LVC_Color_MLK_Graph rgb(160, 128, 64) Loudness graph: Color for MLK curve 
LVC_Color_MLK_Tolerance rgb(65, 176, 223)  

(light petrol-
blue) 

MLK meter: Color between (Target Value + Tolerance) 
and (Target Value - Tolerance) 

LVC_Color_Numeric_Invalid rgb(0, 0, 0) 
(black) 

All numeric meters: Text color in invalid state (when data 
of prior analysis is displayed, but data has changed 
meanwhile) 

LVC_Color_SLK_Above rgb(155, 155, 
155)  
(dark gray) 

SLK meter: Color above (Target Value + Tolerance). See 
MaximumShorttermLoudnessLevel (Loudness Set Core) 
and LVC_SLK_Tolerance. 

LVC_Color_SLK_Below rgb(215, 215, 
215)  
(light gray) 

SLK meter: Color below (Target Value - Tolerance) 

LVC_Color_SLK_Graph rgb(0, 128, 160)  
(petrol-blue) 

Loudness graph: Color for SLK curve 
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Parameter Name Default Value Description 

LVC_Color_SLK_Tolerance rgb(65, 176, 223)  
(light petrol-
blue) 

SLK meter: Color between (Target Value + Tolerance) and 
(Target Value - Tolerance). 

LVC_Color_TP_1 rgb(243, 178, 0)  
(orange) 

TP meter: Color between values of parameters 
MaximumTruePeakLevel (Loudness Set Core) and 
LVC_TP_Range1 

LVC_Color_TP_2 rgb(155, 155, 
155)  
(dark gray) 

TP meter: Color between values of parameters 
LVC_TP_Range1 and LVC_TP_Range2 

LVC_Color_TP_3 rgb(215, 215, 
215)  
(light gray) 

TP meter: Color below value of parameter 
LVC_TP_Range2 

LVC_Color_TP_Above rgb(255, 46, 18)  
(red) 

TP meter: Color above value of parameter 
MaximumTruePeakLevel (Loudness Set Core) 

LVC_MLK_Tolerance 1.0 Momentary loudness tolerance. See LVC_MLK_Target. 
LVC_SLK_Tolerance 1.0 Shortterm loudness tolerance. See LVC_SLK_Target. 
LVC_TP_Range1 -3.0 dbTP meter: Color range border between 

MaximumTruePeakLevel and LVC_TP_Range2. 
LVC_TP_Range2 -9.0 dbTP meter: Color range border between LVC_TP_Range2 

and lower limit. See Loudness Set Core. 
The color values in hex format RRGGBB are equivalent to rgb(r,g,b) with r, g, b in decimal. (For example, #ffff00 
or #FFFF00 is equivalent to rgb(255, 255, 0)). 

Note: Colors not depending on loudness values are part of MTE's GUI color sets, as described in Section 4.2 on 
page 18. 
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 Loudness Visualization Controls Layout Set  

The layout of loudness controls is bundled in a rectangular grid, as seen in the Loudness Meter and the Loudness 
Track header. The grid consists of a list of rows, each containing a comma-separated list of controls which share 
the width of the row equally. Each control may be used only once (with the exception of Empty) in the complete 
grid. The grid layout can be defined in parameter sets. In MTE there are two sets defined: 

 LoudnessPane_ (layout of the Loudness Meter) 

 LoudnessTrack_ (layout of header content in Loudness Track) 

3.3.1. Supported controls 

 Numeric data display of current value:  CurrentTP, CurrentMLk, CurrentSLk (synonym: CurrentdBTP) 
(new with LVC1.0.31.0)  

 Numeric data display of maximum value: MaxTP, MaxMLk, MaxSLk (synonyms: dBTP, TP, MaxdBTP, MLk, 
SLk) 

 Numeric data display: ILk, LRA, dBTP, MLk, SLk 

 Bar graph display: dBTPMeter, MLkMeter, SLkMeter 

 Control bar with start/stop buttons and time display: ActivationControl 

 Loudness history graph: HistoryEnableControl, HistoryControl 

 Loudness ear showing the loudness quality: LoudnessEar 

 Empty spaces: Empty. (This is intended for creating an empty space in the layout and may be used 
multiple times. You can add a number in braces to set a fix width in pixels (e.g. "empty (2)")) 
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3.3.2. Example Configurations 

For MTE's LoudnessMeter 
LoudnessPane_Row1 = ILk, LRA 
LoudnessPane_Row2 = dBTPMeter, MLkMeter, SLkMeter 
LoudnessPane_Row3 = ActivationControl 
LoudnessPane_Row4 = HistoryEnableControl 
LoudnessPane_Row5 = HistoryControl 

 
(MTE's default configuration is shown.) 

 

 

For MTE's LoudnessTrack 
LoudnessTrack_Row1 = ILk, LRA 
LoudnessTrack_Row2 = MLk, SLk  
LoudnessTrack_Row3 = dbTP, Ear 

(MTE's default configuration is shown.) 
 

 

 List of MTE Specific Loudness Settings  

All MTE-specific loudness settings are listed in the table below. Many "Common" parameters can be evaluated 
by other applications supporting loudness features, too. 

Parameter Name Parameter Location Default 
Value 

Description 

EditorLoudnessSet Common|Loudness (none) Specifies the name of the loudness 
set from 
|Common|Loudness|<LoudnessSetNa

me>| (used by all editors). 

If this parameter is missing, all 
loudness features are disabled in the 
Audio Editors. 

DisableLoudness Common|Loudness FALSE Enables/disables (TRUE/FALSE) 
loudness features. 
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Parameter Name Parameter Location Default 
Value 

Description 

ClipboardAutoLoudnessAnalysis <AppName>|Settings|Loudness (none) Controls if the loudness analysis is 
launched automatically for each 
audio coming into the clipboard. 

LoudnessPane_Row<num> <AppName>|Settings|Loudness (none) Defines the configuration for 
loudness controls displayed in the 
Loudness Meter. If not set, a default 
layout will be applied. For each row 
one parameter must be set where 
<num> is incremented consecutively 
starting with 1. 

LoudnessTrack_Row<num> <AppName>|Settings|Loudness (none) Defines the configuration for 
loudness controls displayed in the 
loudness track's head. If not set, a 
default layout will be applied. For 
each row one parameter must be 
set where <num> is incremented 
consecutively starting with 1. 

GUILoudnessUnit <AppName>|Settings|Loudness "LUFS" User GUI option for loudness unit 
(requires user right 
MTE_ChangeLoudnessDisplaySettin
gs). Possible values: "LU", "LUFS" 

GUILoudnessScale <AppName>|Settings|Loudness "Plus9" User GUI option for loudness scale 
(requires user right 
MTE_ChangeLoudnessDisplaySettin
gs). Possible values: 
"Plus9", "Plus18" 

GUILoudnessGraphDisplayValue <AppName>|Settings|Loudness "Slk" User GUI option for displayed values 
in loudness graph (requires user 
right 
MTE_ChangeLoudnessDisplaySettin
gs). Possible values:"Slk", "Mlk", 
"Mlk + Slk" 

IntegrationInitiallyActive MultiTrack\Settings\Loudness 0 Activates/deactivates the 
integration by default. 1=active, 
0=inactive 

LoudnessTrackVisible <AppName>|Settings|UIMultiT

rack 

0 Defines whether the Loudness Track 
of the MultiTrack page is visible (1) 
or not (0). This value is written to 
the USER registry by MTE when the 
user interactively displays or hides 
the Loudness Track. 

LoudnessTrackHeight <AppName>|Settings|UIMultiT

rack 

56 Defines the height of the Loudness 
Track of the MultiTrack page in 
pixels. This value is written to the 
USER registry by MTE when the user 
interactively changes the height of 
the Loudness Track. 
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Parameter Name Parameter Location Default 
Value 

Description 

Checkbox_SaveLoudnessComplia
nt 

<AppName>|Settings|Loudness 2 Determines whether the "Save 
loudness compliant" checkbox is 
visible in Save dialogs: 0=invisible; 
1=visible and initially checked; 
2=visible and initially unchecked 

HistoryVisible Multitrack|Settings|Loudness 1 Stores the user’s last setting 
regarding visibility of loudness 
meter's history control. The setting 
is loaded at program restart.  
0=invisible or 1=visible (initially 
checked).  
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4. GUI Configuration 

 GUI Settings (All Editors) 

The new GUI brings some new configurations on administrator level of parameters. 

4.1.1. Structure of Parameters 

For every work page (e.g. SingleTrack page) an individual sub key is created in the section Settings. Therefore 
every page can be configured individually. The sub keys are: 

 Settings/UIEasyTrack  Settings/UIRecordMode 

 Settings/UIMultiTrack  Settings/UIReporterBox 

 Settings/UIOCX  Settings/UISingleTrack 

The layout is saved in the corresponding key when the editor is closed. To save changes the option "Save Layout” 
in Options -> Settings -> Global 2 has to be checked. 

As there are no parametrical interferences between the new and old user interface, version earlier than V5.5 
can be installed parallel without problems. 

4.1.2. Layout Lock 

In Settings the Parameter UILockLayout=1 may be set. With this setting the moving or re-arranging elements of 
the user interface is not possible. 

Some areas may be excluded from the lock. It is required that the parameter UILockLayout=1 is set. When the 
value 0 is assigned to these parameters, the corresponding function is executed and possible in spite of the lock. 

UILockDockedPaneClose A section’s close button works (Default=1) 

UILockDockedPanePin A section’s pin function is active (Default=1) 

UILockDockedPaneSize Sections are scalable in size as before (Default=0) 

UILockPaneDocking The sections may be docked to the main window (Default=1) 

UILockPaneUndocking The sections may be undocked from the main window (Default=1) 

UILockToolBarDocking The tool bars may be docked to the main window (Default=1) 

UILockToolBarUndocking The tool bars may be undocked from the main window (Default=1) 

4.1.3. Define Custom Default Layout  

For the allocation and arrangement of the individual areas in the editor there may be created a default setting 
(e.g. clipboard is always on top). This default setting may be recovered in the menu Window -> Default Layout 
at any time. 

To define a new default layout, follow these steps: 

1) Arrange the sections in the way you wish.  

2) Make sure that the option under Options -> Settings -> Global 2 – Save Layout is flagged. 

3) Close the Editor, open the DigaSystem Administrator and expand the Settings sub key of the editor (e.g. 
|MultiTrack|Settings|) 
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Under Settings change the names of the sub keys as described below. The sub key name indicates the affected 
editor working page, e.g. UIReporterbox defines the layout of the Reporterbox Page: 

Sub key name: Rename into: Sub key name: Rename into: 

UIEasyTrack DefaultUIEasyTrack UIRecordMode DefaultUIRecordMode 

UIMultiTrack DefaultUIMultiTrack UIReporterbox DefaultUIReporterbox 

UIOCX (custom OCX pages) DefaultUIOCX UISingleTrack DefaultUISingleTrack 

4) Restart the editor and remove the check mark at "Save Layout” under Options -> Settings -> Global 2. The 
parameters named above are newly created when the Editor is closed again. 

The Layout parameters are read out in this order: 

1) Saved layout parameter set 

2) Saved default layout parameter set 

3) Hard corded layout parameter set 

As soon as the menu command Window -> Default Layout is executed, a default configuration is searched by 
this order: 

1) Saved default layout parameter set 

2) Hard corded layout parameter set 

 GUI Color Sets  

 
The Audio Editors now have a customizable color set. The set is defined in a subkey of the editor settings on 
parameter level. The set is then activated by a parameter. Former color parameters (listed under 
…|<EditorName>|GUI| and starting with "Clr…” ) still work, but will not be read if the corresponding ColorSet 
parameter covering the same GUI area is active. 
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4.2.1. Color Set Parameters 

Here's a list of all parameters included in the ColorSet. As values an rgb value can be entered or a color name 
from the list below in 4.2.3 Available Color Names. The parameters are inactive until the ColorSet is activated 
(see below). Without these parameters manually being entered the editors use a default configuration (not the 
default values in this list) and refer to older parameters (…|<Editor>|GUI|). 

Parameter name Default value  Description 

Color_ClipboardBkgnd rgb(255,255,255) Background of clipboard (with Effects subpage and tab 
header) 

Color_EasyTrackFadeLine rgb(0,0,0) ETS: Volume line color 

Color_EasyTrackInside rgb(193,213,255) ETS: Color of marked area outside of elements 

Color_EasyTrackInsideObject rgb(150,230,240) ETS (with ETS MTS' parameter Color_TrackInsideObject 
is overwritten by this one) 

The color of EasyTrack page Objects between MarkIn 
and MarkOut. 

Colors can be input either as HTML color code or in the 
format used by other color functions of EasyTrack (see 
for example EasyTrack|Settings|DefaultClipColor). 

Color_EasyTrackInsideObject-
Select 

rgb(137,174,185) ETE (with ETS MTS' parameter Color_TrackInsideOb-
jectSelect is overwritten by this one) 

The color of EasyTrack page selected Objects between 
MarkIn and MarkOut. 

Colors can be input either as HTML color code or in the 
format used by other color functions of EasyTrack (see 
for example EasyTrack|Settings|DefaultClipColor). 

Color_EasyTrackObject rgb(204,248,204) ETE (with ETS MTS' parameter Color_TrackObject is 
overwritten by this one) 

The color of EasyTrack page Objects. 

Colors can be input either as HTML color code or in the 
format used by other color functions of EasyTrack (see 
for example EasyTrack|Settings|DefaultClipColor). 

Color_EasyTrackObjectSelect rgb(89,161,89) ETE (with ETS MTS' 
parameter Color_TrackObjectSelect is overwritten by 
this one) 

The color of EasyTrack page selected Objects. 

Colors can be input either as HTML color code or in the 
format used by other color functions of EasyTrack (see 
for example EasyTrack|Settings|DefaultClipColor). 

Color_EffectActive rgb(164,251,202) Defines the color of the effect buttons (EQ, Subsonic, 
Compressor buttons) when this effect is active. 

Color_LoudnessMeterBkgnd  rgb(80,80,80) MTS: Defines the color of the loudness meter pane. 
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Color_LoudnessTrackHead rgb(80,80,80) MTS: Defines the color of the loudness track head.  

Color_PreTrackArea rgb(240,240,240) for MTS: Empty area between track head and timeline 
with a fixed soundhead  

Color_SingleTrackFadeLine rgb(0,0,0) = black for STS: Defines the color of the fading line in 
singletrack screen 

Color_Soundhead rgb(51,153,153) MTS, ETS, STS, RMS: Soundhead and textual soundhead 
time in MTS 

Color_TimelineBkgnd_MTS rgb(150,177,232) MTS: Background of empty space below tracks 
including frame and screen switching tab below 

Color_TimelineBkgnd_STS rgb(111,186,117) STS: Background of empty space below tracks including 
frame and screen switching tab below 

Color_TrackBkgnd_Locked rgb(240,240,240) MTS: Empty area inside track (where no audio is) in 
locked track state 

Color_TrackBkgnd_Normal rgb(255,255,255) 
= white  

MTS: Empty area inside track (where no audio is) in 
normal (=unlocked) track state 

Color_TrackFadeLine rgb(128,0,0) = 
maroon 

MTS: Volume line color 

Color_TrackHead_Selected rgb(205,235,183) MTS: Track head (left area with controls and level scale) 
in selected track state 

Color_TrackHead_Unselected rgb(240,240,240) MTS: Track head (left area with controls and level scale) 
in unselected track state 

Color_TrackInside rgb(193,213,255)  Color of marked area outside of elements 

Color_TrackInsideObject rgb(150,230,240) Color of marked area of an unselected element 

Color_TrackInsideObjectSelect rgb(137,174,185)  Color of marked area of a selected element 

Color_TrackObject rgb(204,248,204) Color of unselected objects 

Color_TrackObjectSelect rgb(89,161,89)  Color of a not marked area of a selected object 

Color_TrackOverviewHead rgb(128,0,0) = 
maroon 

MTS: Color of the sound head in the overview window 

Color_TrackOverviewScreen-
Range 

rgb(244,238,194) 
MTS: Color of the timeline in the overview window 

Color_TrackPanLine rgb(0,122,130) MTS: Color of the pan line 

Color_TrackParameterLine rgb(0,128,0) = 
green 

MTS: Color of the effect parameter line 

4.2.2. Activate Color Set 

The color set is activated by the parameter …|EditorName|Settings|ColorSet=[Name of ColorSet]. As an 
example, if the Color Set parameters are located in the folder …|EditorName|Settings|MTECOLORS, the the 
parameter has to be ColorSet=MTECOLORS 
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4.2.3. Available Color Names 

Color Name/ value RGB values  Color Name/ value RGB values  Color Name/ value RGB values 
 aliceblue 240,248,255  ghostwhite 248,248,255  navajowhite 255,222,173 
 antiquewhite 250,235,215  gold 255,215,0  navy 0,0,128 
 aqua 0,255,255  goldenrod 218,165,32  oldlace 253,245,230 
 aquamarine 127,255,212  gray 128,128,128  olive 128,128,0 
 azure 240,255,255  green 0,128,0  olivedrab 107,142,35 
 beige 245,245,220  greenyellow 173,255,47  orange 255,165,0 
 bisque 255,228,196  grey 128,128,128  orangered 255,69,0 
 black 0,0,0  honeydew 240,255,240  orchid 218,112,214 
 blanchedalmond 255,235,205  hotpink 255,105,180  palegoldenrod 238,232,170 
 blue 0,0,255  indianred 205,92,92  palegreen 152,251,152 
 blueviolet 138,43,226  indigo 75,0,130  paleturquoise 175,238,238 
 brown 165,42,42  ivory 255,255,240  palevioletred 219,112,147 
 burlywood 222,184,135  khaki 240,230,140  papayawhip 255,239,213 
 cadetblue 95,158,160  lavender 230,230,250  peachpuff 255,218,185 
 chartreuse 127,255,0  lavenderblush 255,240,245  peru 205,133,63 
 chocolate 210,105,30  lawngreen 124,252,0  pink 255,192,203 
 coral 255,127,80  lemonchiffon 255,250,205  plum 221,160,221 
 cornflowerblue 100,149,237  lightblue 173,216,230  powderblue 176,224,230 
 cornsilk 255,248,220  lightcoral 240,128,128  purple 128,0,128 
 crimson 220,20,60  lightcyan 224,255,255  rebeccapurple 102,51,153 
 cyan 0,255,255  lightgoldenrodyellow 250,250,210  red 255,0,0 
 darkblue 0,0,139  lightgray 211,211,211  rosybrown 188,143,143 
 darkcyan 0,139,139  lightgreen 144,238,144  royalblue 65,105,225 
 darkgoldenrod 184,134,11  lightgrey 211,211,211  saddlebrown 139,69,19 
 darkgray 169,169,169  lightpink 255,182,193  salmon 250,128,114 
 darkgreen 0,100,0  lightsalmon 255,160,122  sandybrown 244,164,96 
 darkgrey 169,169,169  lightseagreen 32,178,170  seagreen 46,139,87 
 darkkhaki 189,183,107  lightskyblue 135,206,250  seashell 255,245,238 
 darkmagenta 139,0,139  lightslategray 119,136,153  sienna 160,82,45 
 darkolivegreen 85,107,47  lightslategrey 119,136,153  silver 192,192,192 
 darkorange 255,140,0  lightsteelblue 176,196,222  skyblue 135,206,235 
 darkorchid 153,50,204  lightyellow 255,255,224  slateblue 106,90,205 
 darkred 139,0,0  lime 0,255,0  slategray 112,128,144 
 darksalmon 233,150,122  limegreen 50,205,50  slategrey 112,128,144 
 darkseagreen 143,188,143  linen 250,240,230  snow 255,250,250 
 darkslateblue 72,61,139  magenta 255,0,255  springgreen 0,255,127 
 darkslategray 47,79,79  maroon 128,0,0  steelblue 70,130,180 
 darkslategrey 47,79,79  mediumaquamarine 102,205,170  tan 210,180,140 
 darkturquoise 0,206,209  mediumblue 0,0,205  teal 0,128,128 
 darkviolet 148,0,211  mediumorchid 186,85,211  thistle 216,191,216 
 deeppink 255,20,147  mediumpurple 147,112,219  tomato 255,99,71 
 deepskyblue 0,191,255  mediumseagreen 60,179,113  turquoise 64,224,208 
 dimgray 105,105,105  mediumslateblue 123,104,238  violet 238,130,238 
 dimgrey 105,105,105  mediumspringgreen 0,250,154  wheat 245,222,179 
 dodgerblue 30,144,255  mediumturquoise 72,209,204  white 255,255,255 
 firebrick 178,34,34  mediumvioletred 199,21,133  whitesmoke 245,245,245 
 floralwhite 255,250,240  midnightblue 25,25,112  yellow 255,255,0 
 forestgreen 34,139,34  mintcream 245,255,250  yellowgreen 154,205,50 
 fuchsia 255,0,255  mistyrose 255,228,225    

 gainsboro 220,220,220  moccasin 255,228,181    
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 Track configuration 

4.3.1. Volume points in Edit Display Mode  

 Reset volume points to a pre-configured value  

 Parameter: …|MultiTrack|Settings|FadePointResetValue (Value: -200…0dBFS) 

 A double click on a volume point places it between the other volume points without changing the volume of 
the audio. With this parameter the point will be placed at a pre-defined volume, e.g. -9dBFS, effectively 
changing the volume at this point. The value can be set between -200 and 0 dB. If the parameter is not 
entered manually, this feature is not active. 

4.3.2. Default Track Height 

 You can configure a default track height with the following parameters in the section Settings: 

TrackEdit Height of a track in Edit Display mode (max. 256 pixels) 

TrackHeightNormal Height of a track in Block Display mode (max. 512 pixels). This pixel value includes 
the height of the Select Area (see below) 

TrackHeightSelectArea Height of the Select Area in Block Mode (max 46 pixels). The pixel value is part of 
the TrackHeightNormal parameter, not additional. 

 

 

4.3.3. Set default for Volume Scale Type 

 

You can set the scale permanently to dB by setting the parameter 
"ScaletypeST” to 1 (0 means linear) in the Settings. 

 

  



DAVID Systems Audio Editors-V6.5 – Admin Manual Page 23 of 39 

 

 

4.3.4. Phase indicator 

 

The editors automatically look for inverted phases in audio takes being 
imported into the clipboard. This function may be de-/activated in the 
same section with the parameter "Showphase=0|1". 

Thresholds are stored in the Administrator Section  
"MultiTrack|VUMeters", with the following parameters: 

Parameter name Default value 

PhaseThresholdInput -50 

PhaseThresholdOutput -50 

4.3.5. Copy objects from Single Track Editor to MultiTrack/ EasyTrack Editor 

 
By default, multiple objects are transferred as single objects from SingleTrack page to MTS/ETS when 
clicking on “copy to track screen”. By using the parameter "EditStationCopySingleObject=1” these 
single objects are automatically grouped after transfer. 

4.3.6. Sound head  

4.3.6.1. Sound head configuration 
For the moving soundhead the following parameters will determine the "turn pages” behavior of the timeline 
when the sound head reaches the screen border.  
Parameter Value  Description 

MovingSoundheadWorkingArea 60…100 Position (in % of the working area) when the soundhead 
position triggers the page flip. 100 means when the head 
reaches the screen edge. 

MovingSoundheadSkipOnNewPage 0…50 Position (in % of the working area) where the soundhead 
appears after a page flip. 50 means the screen center. 
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4.3.6.2. Use alternate mouse button configuration 
 

 

Parameter Value  Description 

UseAlternateMouseButtons 0/1 If set to 1, the mouse button bindings are changed and 
optimized for working with a mousepad. See also 
ALTERNATE MOUSE CONFIGURATION FOR SETTING 
IN/OUT MARKERS in the User Manual (section 11.7.4) 
 

MTSMouseMode 1/2/3 This parameter modifies the way the mouse is used in the 
tracks of the MultiTrack screen. 
If set to 1, default mouse behavior. Left and right buttons 
set mark in and mark out. A left click in the bottom line 
selects an audio object. A right click in the bottom line 
pops up a menu. Set the sound head by a middle click. 
 
If set to 2, alternate behavior (previously set by 
UseAlternateMouseButtons=1). Mark in and mark out are 
set by holding down the right mouse button while 
moving the mouse over an audio object ("right 
dragging"). A right click in the bottom line pops up a 
menu. A left click in the bottom line selects the audio 
object, and a left click in the waveform sets the sound 
head. A middle click sets mark in. 
 
If set to 3, emulation of EasyTrack screen behavior. Select 
the audio object with a left click. Separate the object with 
a right click. Set the sound head with a middle-click. Use 
the time scale to move mark in and mark out. 
 

Note:  This parameter supersedes the 
UseAlternateMouseButtons parameter, as far as the 
MultiTrack screen is affected.  
If MTSMouseMode is _not_ defined: 
UseAlternateMouseButtons=0 has the same effect as 
MTSMouseMode=1, and UseAlternateMouseButtons=1 
has the same effect as MTSMouseMode=2.  
If MTSMouseMode is defined: it overrides any explicit 
setting of UseAlternateMouseButtons. (The 
UseAlternateMouseButtons parameter also affects other 
screens.) 
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5. MultiTrack Screen Configuration 

 Audio effects: Activate VST plugins 

MTE V6 provides an interface to include VST 2.4 and VST3 effect Plugins by 3rd party distributors. To activate 
this feature open the DigaSystem Administrator and enter the following parameters in the path 
…|MultiTrack|Settings|: 

Parameter Description 

MultiRecVSTEffectsPath 
(VST2 plugins only) 

Defines the path where MTE will search recursively for VST Plugin dlls 
(including  subfolders) 

MultiRecVST3EffectsPath 
(VST3 plugins only) 

Defines the path where MTE will search recursively for VST3 Plugin dlls 
(including subfolders). By default all VST3 plugins are installed to the  
%ProgramFiles(x86)%\Common Files\VST3 folder.  

UseVSTEffects Set to 1 to activate the VST effects in the MultiTrack Editor 

The first MTE launch with the plugins will take more time than usual because the plugins need to be recognized 
and installed. 

5.1.1. Define Preset Paths 

All plugin preset-settings are saved into an xml file per plugin (also applies for non-VST plugins). To be able to 
use such presets you need to define the following parameters in the DigaSystem Administrator path 
…|MultiTrack|Settings|: 

Parameter Description 

AudioFilterPresetPath Define a network path, so you can provide general presets for all 
machines. It is recommended to enter this parameter in the Global 
Settings. Then copy all preset files into this directory, manually. These 
presets cannot be changed or deleted by users  

LocalAudioFilterPresetPath Define a local path for user specific presets that can be changed and 
deleted.  

To make a user specific preset available for all users, simply copy the xml files into the AudioFilterPresetPath. 
The xml files may have confusing file names, but the VST filter name should be mentioned in the file names. 

Information about the plugins is cached in the file %alluserprofiles%\DigaSystem\MultiRec\Vst3FilterList.xml.  

5.1.2. Configure the appearance of the plugin’s presets  

Some but not all plugins have an own preset button that can be used to save the currently defined effect settings 
as a template. With these preset buttons you can load already existing presets, but you cannot create new 
presets or edit existing ones. 

VST2 plugins: To create or edit any templates use the Preset button that is provided by the MultiTrack Editor 
and is located in the effect window as well.  

VST 3 plugins: Only user-defined presets are managed by MTE's "Preset" button in the plugin view's window 
title bar. Built-in presets must be loaded using the plugin's GUI. Of course you can load a built-in preset, and 
save it without any changes as a user-defined one. 
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The appearance of the presets menu items can be configured by setting the following parameter in the 
DigaSystem Administrator path …|MultiTrack|Settings|: 
 

Parameter Default Value Description 

EffectPresetsMenu_Limit 
(VST plugins only) 

(20;15;50)  Defines how the presets menu entries appear. To do 
so, the following specifications have to be made 
(n1;n2;n3).  

User and factory presets can be moved into sub 
menus of the "Presets" menu, if the total number of 
presets exceeds n1, or if the number of user or factory 
presets exceeds n2. You can force this changed 
behavior by setting n1 or n2 to 0. 
 
n3 defines the maximal number of entries per menu 
column. For example, with n3=10, a menu that has 12 
entries would be broken into two columns of 10 and 2 
items. 
 

 

 Audio Effects Waves Version 9 Plugins  

If you would like to use the Version 9 effects of WAVES in the MultiTrack Page, enter the path of the file 
"WaveShell-VST 9.2.dll" (32bit variant) as value of the parameter "MultiRecVSTEffectsPath”. This file will make 
all installed plugins available for MTE. Further this file can be copied into another folder in case you already refer 
to additional plugins via this parameter. 

Important! Some but not all plugins have an own preset button that can be used to save the currently defined 
effect settings as a template. With these preset buttons you can load already existing presets, but you cannot 
create new presets or edit existing ones! 

 GUI optimization on changed screen resolution  

MTE can now adapt to a changed screen resolution (e.g. switching between a laptop display and a second 
monitor screen) and will automatically be set to an optimal arrangement on the screen. To activate this function 
set the parameter:  

Local Settings|MultiTrack|Settings|AutoAdaptMTETrackHeightsEnabled=1 

 Remove automatically selected objects 

By running the commands in the “Edit” menu, e.g. “Separate", "Cut and separate" or "Cut, separate and 
move", an additional object next to the source object is created. If the source or the newly created object 
should be dragged to a different position, then the other object is moved automatically. 
 
To remove the object selection, the parameter “RemoveSelectionWhenSeparating” is available.  
 
Local Settings|MultiTrack|Settings| RemoveSelectionWhenSeparating 

Enabled=1, disabled=0, default=0. 
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 Set the state of the Toggle Waveform Offset button  

To configure the initial state of the offset, the parameter “WaveformOffsetInitiallyActive” is available.  
 
Local Settings|MultiTrack|Settings| WaveformOffsetInitiallyActive 

Active=1, Inactive=0, Default=1. 
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6. Reporterbox Screen Configuration 

 Deactivate Print function 

Parameter Description 

UsePrint Default: 1 

Set this parameter to 0 to grey out print commands in the storyboard context menu.  

 Fader Start with DigaStudio 

 

In the Audio Editor, the play/stop command and the inserting of clips in the ReporterBox may also 
be performed with a fader in DigaStudio. The required parameters already exist, and only must  

be activated. With all "DigaStudioFaderCommand_..."parameters in "Settings” the first value needs to be set 
from 0 to 1. Then, PLAY/STOP will be activated with the first fader. For the ReporterBox, besides PLAY/STOP 
there are more commands, which are described in our parameter database. There you also find other 
information, if for example a different fader should be used. 

 Relay Board Commands 

 

In the Audio Editor, several commands may be executed via relay contacts. The necessary 
parameters already exist and only have to be activated. 

PLAYFRWD 

PLAYFFWD 

DOUBLESTOP 

RECORD 

RECORDPLAY 

SET_MARK 

The corresponding "RelaisCardCommand_..." parameters in Settings must be configured according to the 
specified relay board settings. For more information please see the Technical Manual. 

For the ReporterBox, besides PLAY/STOP there are more commands, which are described in our parameter 
database. There you also find other information, if for example another bit should be useda 
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7. Record Mode Screen Configuration 
The following settings can be defined for all editors. 

 Deactivate Recording function 

Set the parameter "UseRecord=0". By this the red record buttons are blanked out. 

 Show Audio-/Text-Clip 

To show a fourth button that contains the text first, then the audio, can be activated by defining the parameter 
UseRecordScreenTextAudioButton=1 
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8. SingleTrack Screen Configuration 

 Load first imported Take automatically into STE timeline  

Parameter Description 

LoadTakeToSingleTrack With loading of the first take from the DBM to the editor, this take may be 
loaded automatically to the SingleTrack page track. This saves a manual 
loading into the track. 

To activate this feature, set the parameter to 1 (Default 0). 

 Marker Behavior 

Parameter Description 

EditSelectAll After a cut, the markers may remain at their actual position (value 0), or be 
reset to the start / end of the timeline (value 1).  

 Volume Fader button: Position of the volume line 

Parameter Description 

UseFadeStartMiddle When clicking on the Volume Fader button: If the value is 1, then the volume 
line is always in the middle of the marked area, and also allows volume 
corrections outside of the track. Default is 1. 

 Volume Fader Accelerators: Change volume steps 

Parameter Description 

VolumeFaderChange-
Amount 

With the accelerators Volume Fader -> Volume up and Volume Fader -> 
Volume down the volume of the marked area can be changed. The value 
defines the volume step in dB; set "1.0” for 1,0dB. 
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9. Menus 

 File menu handling 

9.1.1. Show/Hide menu options 

All editors: Some of the File menu options can be de-/activated via parameters. All values are set to 1 as default 
(=active): 

Parameter Description 

MenuFileImport Load audio from the file system 

MenuFileOpenProject Open projects from the file system 

MenuFileSaveDatabaseProject Save a project into a database (DBM) 

MenuFileSaveExtended Open the save extended menu and define save formats and templates 

MenuFileSaveProject Save projects into the file system 

MenuFileSaveTakeAndProject Save takes and a project into a database (DBM) 

9.1.2. Special Stereo Save 

 
This menu option allows to create new stereo takes out of one channel of an original audio.  
This feature (if not configured), needs to be activated: 

 Create the new sub key …|<Editor>|ExtMenuCmds. 

 Each of the four supported functions StereoLeft, StereoRight, StereoSplit and StereoMix need three 
parameters to work: 

Parameter Description 

Command_1 (up to 4) Define the action which the respective menu entry should perform. The only values 
which are allowed for these entries are:  

 StereoLeft  

 StereoRight  

 StereoSplit 

 StereoMix 

These values are case sensitive! 

Name_1 (up to 4) The name for the respective menu item which appears in the menu. Name_1 is 
connected to Command_1, and so on. 

Enable_1 (up to 4) Set Enable_1 to TRUE to make this feature available in the editor, and so on. 

When a channel is doubled and a stereo take is created out of a former mono file, this means the signal is 
doubled and the volume is significantly boosted. To avoid this problem the following parameter can help: 

Parameter Description 

MonoToStereoAmplification Reduces the volume of the stereo file that is created with the ExtMenuCmds-
functions. The default is set to -6 (dB) to reduce the created take by that 
amount, which totally covers the volume boost of two identical signals. 
Therefore it generally will not make much sense to change this value. 
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 Automatic clean-up 

Recordings created in Audio Editor normally are deleted manually by "File/Cleanup”.  

This action may be automated with the parameter "RecordAutoCleanup=1". By default, with every restart of 
the Audio Editor, the recordings directory will be checked for files older than 24 hours. These will be deleted. 

 Include HELP file 

Currently the usual help files (.chm) are not up to date. To include any type of help file, proceed as follows: 
Open (or create) the subfolder |<Editor Name>|HelpMenu| and define the following parameters 

Parameter Description 

Command_1 Enter the path of the help file, e.g. c:\digas\helpfile.chm 

MenuName_1 The value is the name shown in the editors HELP menu, connected with the file of 
the Command1 parameter. 

 

For additional HELP menu entries, set the parameters Command_2 and MenuName_2 and so on.  
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10. Projects and Communication 

 Handling of 4GB+ Projects and Files 

The Audio Editors V6 may create audio files bigger than 4GB file size. In such files the normal markers are all 
created in RF64 format (while normal "Cue” markers can only be created within the first 4GB). This means that 
third-party software possibly may not be able to display markers beyond the 4 GB border. 

The Audio Editors V6 are able to save and open projects with a total size exceeding 4GB. It does not matter, 
whether the total size is reached by a single audio file with 4GB+ or if the sum of all files in the project is 
exceeding the 4GB. 

 

Projects exceeding 4GB+ cannot be opened by Audio Editors below V6. The user will be notified by a 
pop-up message, if a session currently being saved as a project exceeds the size of 4GB. 
 

 
 
 

 Save configuration (Takes and Projects) 

10.2.1. Save Extended dialog 

Configure Dialog "Save Extended"  

When calling the command "File – Save extended" the areas "Destination", "File Format", "Audio Format" and 
"Time Stretch" are shown. By the parameter "…|Settings|ShowSaveExtendedSections" single areas can be 
activated (separated by comma): 

Parameter value: Description: 

FILESYSTEM Blanks the area "same in file system" in/out 

FILETYPE Blanks the area "file format" in/out 

AUDIOFORMAT Blanks the area "audio format" in/out 

TIMESTRETCH Blanks the area "time stretch” in/out 

By default all areas are activated: 

"ShowSaveExtendedSections=FILESYSTEM|FILETYPE|AUDIOFORMAT|TIMESTRETCH” 
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10.2.2. Save specific editor screens into a project 

Save only certain work areas 

Per default, all work areas of a project, in which work was performed, will be saved. This may however be altered 
with the parameter "…|Settings|ProjectSaveScreen": 

Parameter Value Description 

ALL Saves content of all work spaces 

ACTIVE Marks only the current work space (default) 

MULTITRACK|EDITSTATION Saves only the track mode of the MultiTrack or SingleTrack view = EditStation. 

REPORTBOX Saves only the content of the ReporterBox 

10.2.3. Deactivate "Reference" or "Data"choice when saving projects 

To obviate user changes to the "Reference” or "Data” default settings in "Options – Settings – Files”, this may 
be deactivated by the parameter "ProjectSaveSoundfileSwitch=0" (Settings) 

10.2.4. Query muted Tracks in the save dialog 

  
Only available for ETS and MTS for having multiple tracks. 

Parameter  Description 

QueryMutedTracks Default is 0; set to 1 to trigger a message, if one or more tracks are currently 
muted (so they would be audible in the resulting saved audio file.  

 NamedPipes Communication protocol  

"NamedPipe” is a new communication protocol between the Audio Editors and DBM (and the broadcast 
scheduling software DigAIRange). It succeeds the older, more fragile communication types DDE and COPYDATA. 
This protocol can be activated with the following parameters: 

1) Global Settings|DDESettings|MultiTrack|Communication_Type=NamedPipes 

(This parameter configures MultiTrack to receive data via NamedPipes) 

2) Global Settings|DDESettings|Database Manager 32 Bit|Communication_Type=NamedPipes 

(This parameter configures DBM to receive data via NamedPipes) 

3) Settings|DBM|Communication|UseNamedPipes=DIGASDBM, MultiTrack-Editor, EasyTrack 

(The applications being named in the value will send data with the NamedPipes protocol; optionally the 
value "DigAIRange” can be added, here) 

 MTE specific rights objects 

The following list shows all Audio Editor rights in DigaSystem and standalone mode. In standalone mode these 
objects are read from the section "[Rights]”. The Auto_Change rights affect the GUI settings, accessible by the 
menu "Options –> Settings”. If the right is granted (INI: entered) the corresponding section becomes available 
and can be edited. 

Digas Right INI Right Description 

Auto_Change_Accelerators ChangeAccelerators Access settings tab "Accelerators”  
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Digas Right INI Right Description 

Auto_Change_Audio ChangeAudio Allows the user to change the following playback 
functions in the editor settings: "Scrub" fields 
(Global 1 tab), "Play Time" fields (Track tab)  

Auto_Change_Audiocreate-
Format 

ChangeAudiocreate-
Format 

Audio and video editors: Allows the user to 
create audio format save templates (File menu -
> Save extended; "Define…" button)  

Auto_Change_AudioFilter ChangeAudioFilter Access to settings tab "AudioFilter" 

Auto_Change_Hardware ChangeHardware Allows the user to change these parts of the 
MultiRec section of the program settings-> 
Global 1 tab: MultiRec Settings, Cloack, 
Emphasis, Digital Volume, Professional and the 
settings "Audio Channels" tabs. 

Auto_Change_Logging ChangeLogging Audio and video editors: Allows the user to 
change the following sections in the "Logging" 
tab of the program settings: Program, MultiRec  

Auto_Change_Marker ChangeMarker Audio and video editors: Allows the user to 
change the following playback functions in the 
editor settings:  

"Default marker names" fields (Global 2 tab)  

Auto_Change_Record_Input ChangeRecordInput Audio and video editors: Allows the user to 
change the following playback functions in the 
editor settings:  

"Source" fields (Record Input tab) 

Auto_Change_Setup ChangeSetup General access to the settings 

Auto_Change_Textformat ChangeTextformat Access to menu item Options -> Text format 

Auto_Change_Timeformat ChangeTimeformat Access to the timebar settings  

Auto_Change_Track ChangeTrack Allows the user to change the following sections 
in the "Track" tab of the program settings: Global 
Settings, Display, Resolution, Fade In/Out, 
Default Sync (the Play Time section depends on 
the action right Auto_Change_Audio)  

MTE_Admin Not needed! This rights object must be present to enable the 
"save parameters" dialog when shutting down 
any Audio Editor. Users who have this right will 
see the dialog window. Not available in stand 
alone mode. 
Hint: Also ADMIN reads this object and won't 
show the "save parameters" dialog if the rights 
object does not exist.  

MTE_ChangeLoudness-
DisplaySettings 

ChangeLoudnessDisplay-
Settings 

Access to the settings menu in the Loudness 
Meter and Loudness Track 

MTE_LoudnessMeter LoudnessMeter Enables the loudness meter  
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Digas Right INI Right Description 

MTE_LoudnessProcessing LoudnessProcessing Audio objects in the editor clipboard can be 
Loudness analyzed and normalized 

MTE_LoudnessTrack LoudnessTrack Enables loudness track (the track shows the 
loudness data of the objects in the timeline) 

MTE_TrackRecording TrackRecording Enables the recording function in the MTE screen 

MTE_TrackRouting TrackRouting Enables the sound card channel routing feature 
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11. Hardware Specific Configuration 

 Hardware Parameters  

This chapter refers only to editors in the DigaSystem and has no meaning for standalone editors. 

In contrary to earlier editor versions hardware specific parameters are no longer read out in the order User -> 
Local Settings -> Global Settings or the order set by the parameter …|xxxtrack|Flags|DefaultLocationPriority.  

11.1.1. Affected Parameters 

This special regulation refers to this parameters: 

 AudioBoardIn_1_Descr 

 AudioBoardIn_1_Id 

 AudioBoardIn_Count 

 AudioBoardOut_1_Descr 

 AudioBoardOut_1_Id 

 AudioBoardOut_Count 

 TrackRoutingEnabled 

 MultiRecAudioBoardInDescription 

 MultiRecAudioBoardInID 

 MultiRecAudioBoardInputLineFaderID 

 MultiRecAudioBoardInputMicFaderID 

 MultiRecAudioBoardMonitorLineFaderID 

 MultiRecAudioBoardMonitorMicFaderID 

 MultiRecAudioBoardOutDescription 

 MultiRecAudioBoardOutID 

 MultiRecAudioBoardOutputFaderID  

 MultiRecAudioBoardPlaySampleRate 

 MultiRecAudioBoardRecordSampleRate 

 MultiRecUseWaveInToWaveOut 

 MultiRecVolumeInUseMixer 

 MultiRecVolumeOutUseMixer 

 MultiRecVolumeOutUseWaveOutSetVolume 

 MultiRecVideoBoardInID 

 MultiRecVideoBoardOutID 

 

11.1.2. Parameter Query at Startup 

 Hardware specific parameters are first read out of the local settings. When they don’t exist, they are read 
out of the user registry or the default value is used. 

 When the user has writing rights in the local settings, the parameters, which don’t exist, are newly created 
there. 

 When the user has no writing rights in the local settings, the parameters, which exist neither in the local 
settings nor in the user registry, are written to the user registry. 

11.1.3. Writing Access at Closing  

Changed parameters are written into the local settings, when writing rights are granted. When these rights are 
missing, the parameters are written to the user registry. 

 ASIO Monitoring  

Enable monitoring while recording when using ASIO cards as recording source. If enabled the input audio is 
routed to the "Out1+2” output channels while recording is active (with a low latency). To activate this function, 
set the parameter: 

The ASIO monitoring function is also definable individually for each working page with recording functions: 
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Working Page: Parameter Value (on/off) 

All …|MultiTrack|Settings|AsioMonitoring 0,1 

Record Page …|MultiTrack|Settings|AsioMonitoring_Reporterbox 0,1 

Reporterbox Page …|MultiTrack|Settings|AsioMonitoring_RecordPage 0,1 

MultiTrack Page …|MultiTrack|Settings|AsioMonitoring_MultiTrack 0,1 

The three individual working page parameters have a higher priority, than the general "AsioMonitoring” 
parameters. This means, "AsioMonitoring” only works e.g. in the Reporterbox Page, if 
"AsioMonitoring_Reporterbox” has not been entered. 

 Configurable ASIO Playout Buffer Parameters  

The delay of output fader and edit actions being applied to audio playout on ASIO devices can be reduced by  

Configuring the count and size of the playout buffers for ASIO devices.  

Parameter Value Description 

AsioPlayBufferCount 

 

2…16  

Default: 8  

The number of buffers used for ASIO playout.  

AsioPlayBufferSize 512…16384  

Default: 8192 

(stereo samples, which 
corresponds to 64 KB;  

Value 1 = 8 bytes) 

The size of the buffers (number of stereo samples) being 
used for ASIO playout.  

Only powers of 2 are recognized. For other values the 
next higher power of 2 is used. The editor needs to be 
restarted after any change. 

 
Attention: The buffer size should not be less than the one configured in ASIO device's driver settings to 
avoid defective playout.  
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